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General Safety Summary

Review the following safety precautions carefully before operate the device to 
avoid any personal injuries or damages to the device and any products 
connected to it.
To avoid potential hazards use the device as specified by this user’s guide 
only.
 
      To Avoid Fire or Personal Injury
 
      Use Proper Power Cord. Use only the power cord specified for this 

product and certified for the country of use.
 
      Connect and Disconnect Properly. Do not connect or disconnect 

probes or test leads while they are connected to a voltage source.
 
      Connect and Disconnect Properly. Connect the probe output to the 

measurement device before connecting the probe to the circuit under test. 
Disconnect the probe input and the probe reference lead from the circuit 
under test before disconnecting the probe from the measurement device.

 
      Observe All Terminal Ratings. To avoid fire or shock hazard, observe all 

ratings and markings on the product. Consult the product manual for 
further ratings information before making connections to the product.

 
      Use Proper Probe. To avoid shock hazard, use a properly rated probe for 

your measurement.
 
      Avoid Circuit or Wire Exposure. Do not touch exposed connections and 

components when power is on.
 
      Do Not Operate With Suspected Failures. If suspected damage occurs 

with the device, have it inspected by qualified service personnel before 
further operations.

 
      Provide Proper Ventilation. Refer to the installation instructions for 

proper ventilation of the device.
 
      Do not operate in Wet/Damp Conditions.
 
      Do not operate in an Explosive Atmosphere.
 
      Keep Product Surfaces Clean and Dry.
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Chapter 1 Getting Start

 
The oscilloscope is small, lightweight, no external power required, portable 
oscilloscopes! The oscilloscopes is ideal for production test, research and 
design and all of the applications involving analog circuits test and 
troubleshooting, as well as education and training.
 
In addition to the list of general features on the next page, this chapter 
describes how to do the following tasks:

 
      System Requirements
 
      Install Software
 
      General Features
 
      General Check
 
      Probe compensation 
 
      Function check
 
      Self calibration 
 
      Accessories
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System Requirement

To run the oscilloscope software, the needs of computer configuration are as 
follows:
 
Minimum System Requirements
Operating System
Window 2000/XP/VISTA/7
 
Processor
Upwards of 1.00G processor
 
Memory
128M byte
 
Disk Space
500M disk free space
 
Screen resolution
800 x 600
 
Recommended Configuration
Windows XP SP2 System
2.4G Processor
512M Byte Memory
80G Disk Space
1024 x 768 or 1280 x 1024 resolution
DPI Setting: Normal Size (96DPI)
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Install Software

Caution: You must install the software before using the oscilloscope.

1. While in Windows, insert the installation CD into the CD-ROM drive.

2. The installation should start up automatically. Otherwise in Windows 
Explorer, switch to the CD-ROM drive and run Setup.exe.

3. The software Installation is started. Click 'Next' to continue. 

 
 
4. Choose a destination directory. Click 'Next' to continue. 
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5. Check the setup information. Click Next to start copying of files.

6. This Status dialog is displayed during copying of files. 
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7. Updating Your System Configuration.

8. The installation is complete.
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Install Driver

1.        Connect the A-Type Plug of USB cable to your PC’S USB port.

   
2.        Connect the B-Type Plug of USB cable to Hantek 6022BE’S USB port.

     
3. New hardware is found.

    

4.New hardware search wizard starts.
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5.New hardware search wizard starts to search the driver.

   

6.New hardware wizard installs “Hantek 6022BE DRIVER ”.
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7.The wizard has finished installing for “Hantek  6022BE DRIVER ”.
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General Features

 
Product features:
      Dual Channel, Bandwidth: 48MSa/s

      Maximum real-time sample rate: 1Mbytle/channel

      Automatic setup for ease of use (AUTOSET);
  
      20 Automatic measurements;
 
      Automatic cursor tracking measurements;
 
      waveform storage;
 
      User selectable fast offset calibration;
 
      Add, Subtract , Multiply and Division Mathematic Functions;
 
      Adjustable waveform intensity, more effective waveform view;
 
      User interface in several user-selectable languages;

Function Check

Perform this functional check to verify that your oscilloscope is operating 
correctly.

 Connect the oscilloscope
You should connect the A-Type Plug of USB cable to your PC USB port 
and connect the B-Type Plug of USB cable to oscilloscope USB port.
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 Input a signal to a channel of the oscilloscope
The oscilloscope is equipped with dual channels plus external trigger.

Please input signal in the following steps:

1. Set the attenuation switch on the probe as 10X and connect the probe 
on the oscilloscope with CH1. Aim the slot in the probe connector at 
the faucet on BNC of CH1 and insert, then, turn right to lock the 
probe. Finally, attach the tip of probe and ground nip to the Connector 
of Probe compensator.

2. Set the CH1 probe attenuation of the oscilloscope to X10. (The default 
is X1). 

              

3. Attach the tip  of  probe and ground nip  to  the Connector  of  Probe 

compensator. Click the   button. A square wave will be displayed 

within a several seconds. (Approximately 1 kHz, 2V, peak- to- peak). 
Inspect CH2 with the same method. 

4. Repeat steps 2 and 3
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Probe Compensation

Perform this function to match the characteristics of the probe and the channel input.  

This should be performed whenever attaching a probe to any input channel at the first 

time.

■ From the “Probe” menu, select attenuation to 1:10. Set the switch to “X10” on the 

probe and connect it to CH1 of the oscilloscope. When using the probe hook-tip, insert 

the tip onto the probe firmly to ensure a proper connection.

■ Attach the probe tip to the Probe Compensator and the reference lead to the ground 

connector, select CH1, and then press the “AUTOSET“ button into the menu or the 

toolbar.

■ Check the shape of the displayed waveform.

              

Correctly Compensated

             

                 Over compensated
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                  Under Compensated
■ If necessary, use a non-metallic tool to adjust the trimmer capacitor of the probe for 

the fattest square wave being displayed on the oscilloscope.

                 

■ Repeat if necessary.

WARNNING: To avoid electric shock while using the probe, be sure the perfection of the 

insulated cable, and do not touch the metallic portions of the probe head while it is 

connected with a voltage source.

Self Calibration

The self calibration routine lets you optimize the oscilloscope signal path for 
maximum measurement accuracy. You can run the routine at any time but you 
should always run the routine if the ambient temperature changes by 5  or ℃
more. For accurate calibration, power on the oscilloscope and wait twenty 
minutes to ensure it is warmed up. To compensate the signal path, disconnect 
any probes or cables from the input connectors. Then, access the “Menu -> 
Utility -> Calibration” option and follow the directions on the screen. The self 
calibration routine takes about several minutes.

Accessories

All the accessories listed below are standard accessories for the oscilloscope:
 Probe×2 (1.5m), 1:1, (10:1) Passive Probes
 A User’s Guide
 An USB Cable
 A PC software of the oscilloscope
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Chapter 2 Operating Basics 

      The User’s Interface
 
      The Menu System
 
      The Vertical System
 
      The Horizontal System
 
      The Trigger System
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The User’s Interface

Click the software icon on the desk after you finished the software setting and 
equipment connecting. Then a user interface will be showed as follows:

In addition to displaying waveforms, the display area is filled with many details 
about the waveform and the oscilloscope control settings.

1. The Main Menu
All settings can be found in the main menu.

2. The Toolbar

15
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3. Control Panel

4. The Horizontal Panel
The user can change Time/Div, format in the panel.

5. The Vertical Panel
The user  can turn on/off  the CH1/CH2. Also the user  can change the 
CH1/CH2 volt/div, coupling and probe attenuation.

6. The Trigger Panel
In this panel, the user can change the trigger mode, sweep, source and 
slope.

7. It shows the system time.

8. Sample Rate

9. It shows the main time base setting.

10. It shows the CH2 information
Readouts show the coupling of the channels.
Readouts show the vertical scale factors of the channels.
A “B” icon indicates that the channel is bandwidth limited.

11. It shows the CH1 information
Readouts show the coupling of the channels.
Readouts show the vertical scale factors of the channels.

12. Output Window

13. The markers show the reference points of the displayed waveforms. 
If there is no marker, the channel is not displayed.

14. The same as 13.

15. Measure Window.

16
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The Menu System

The Main Menu

  

1. File: Load or Save data, setup

2. View: Change the user interface

17
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3. Cursor: Cursor measure setup

4. Display: The waveform display setup

5. Utility: Utility setting

6. Help: Turn on help file

The Vertical System

The following figure shows the vertical system menu. It shows the vertical 
parameters setting.

18
The User’s Manual



                                                        Hantek 6022BE                                                            

1. CH1: Leads to the setting of the CH1 parameters
2. CH2: Leads to the setting of the CH2 parameters
Use the left mouse button to dragging the channel icon to set the vertical 
position offset precisely.
Invert: The invert function turns the displayed waveform 180 degrees.

The Horizontal System

The following figure shows the Horizontal System window. It shows the 
horizontal parameters settings.

              

1. Time/DIV: leads the setting of the time base parameters
2. Format: leads the setting of the horizontal format parameters
The time base ranges of the oscilloscope is listed as follows. The horizontal 
scan speed is from 4ns/div to 1hour/div.
In the “Format” menu of the “Horizontal” menu, select the display mode to Y-
T, X-Y .
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The Trigger System

The following figure shows the trigger system control. 

Mode: Sets the trigger mode to Edge trigger

     

Sweep: Selects the trigger sweep mode to AUTO, NORMAL or SINGLE

     

Source: Selects the trigger source to CH1, CH2, ALT, EXT or EXT/10

     

Slope: Selects the edge trigger slope to Positive or Negative slope

     

The user can drag the trigger icon to adjust the trigger level and the trigger 
level will be displayed on the top right corner.
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Input Connectors

CH 1/CH 2: Input connectors for waveform display.
EXT.: Input connector for an external trigger source. Use the Trigger Menu to 

select the Ext. or Ext./10 trigger source.
Other Connector:

GND.: a ground terminal

USB PORT: Connect the B-Type Plug of USB cable to this port.

CAL.: Probe compensation output.
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Chapter 3 Understanding Function

 Set Oscilloscope

 Set Vertical System

 Set Horizontal System

 Set Trigger System

 Utility Function

 Measure Signal

 Utility Function

 Save and Load

 Print

22
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Set Oscilloscope

Save Setup
The oscilloscope software saves the current setup before you close the 
oscilloscope software. The oscilloscope recalls this setup the next time 
you run the software. You can use the “Save Setup” menu to permanently 
save up to several different setups.

 
Load Setup

The oscilloscope can recall the last setup before the oscilloscope software 
was running, any saved setups, or the factory setup. You can use the 
“Load Setup” menu to permanently recall a setup. 

Factory Setup
The oscilloscope software is set up for normal operation when it is 
shipped from the factory. This is the factory setup. To recall this setup, 
push the “Factory Setup” menu.

Set Vertical Systems

The CH1/CH2 control panel in sidebar
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The Vertical Menu function:

 Turn ON/Off: Turn on/off the channel

 Volt/DIV: Select the channel voltage/div

 Coupling: Select the channel coupling

 Probe: Select the channel probe attenuation

 Change Volt/DIV

You can click “Volt/Div” in “CH1/CH2” Menu to select the voltage

You can also change “CH1/CH2” voltage in sidebar

You can left click and drag the mouse on the green knob or the yellow knob to 
change the voltage. 
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 Set Channel Coupling

Click “Coupling” in “Channel” menu

In the sidebar, you can change the channel coupling too.

You can set the coupling to DC, AC or GND. If you set the coupling to DC, it 
blocks the AC component of the input signal.

 Probe Attenuation Setting

Select the attenuation factor for the probe. To check the probe attenuation 
setting, toggle the probe menu to match the attenuation factor of the probe.
This setting remains in effect before you changed again.

Click “Probe” in Channel menu to select the probe attenuation

The probe setting window in the sidebar

Note: The attenuation factor changes the vertical scale of the oscilloscope so 

that the measurement results reflect the actual voltage levels at the probe tip.

 Invert

The invert function turns the displayed waveform 180 degrees, with respect to 
the ground level. When the oscilloscope is triggered on the inverted signal, 
the trigger is also inverted.

Click “Invert”  
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Turn off invert

Turn on invert

The following picture shows the waveform before inversion:
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The following picture shows the waveform of inversion:

Set Math

Click  in Toolbar.

The MATH Menu:
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 Turn On/Off: Turn On/Off the MATH Channel.

 Source A/B: Set the sources of the math channel.

The mathematic functions include addition, subtract, multiply and division for 
CH1 and CH2.

In this function, use the addition, subtraction, multiplication,division function 
and FFT to operate and analyze the waveform.

Select source A and B. Then adjust the vertical scale and offset to view the 
math channel clearly. The mathematic result can be measured by the 
measure and the cursor.

 The Math Function Display

28
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Fast Fourier Transform Function

You can use the FFT mode to convert a time-domain signal into its frequency 
components (spectrum). You can use the FFT mode for the following types of 
analysis:

 Measure harmonic content and distortion in systems

 Characterize noise in DC power supplies

 Analyze harmonics in power lines

 Analyze vibration

To use the FFT mode, you need to click  in Toolbar to open the FFT setup 

window. 
The FFT setup window:
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You can select the Source channel, Window algorithm, FFT number, and FFT 
Zoom factor. It displays only one FFT spectrum at a time.

Source:

Selects the channel used as the FFT source

Window:

Selects the FFT window type

Scale:   

Selects the vertical scale units

Vert Scale：

Selects the vertical scale

HORI Scale: 

Selects the FFT zoom factor
Sets horizontal scale, If the information is more than the quantity displayed to 
the display window, more information is displayed by using scroll bar.

You can click the  button to start FFT math, also you can click this 

button to stop FFT math.
Click “Save” button if you want to save FFT math result. You can save the 
data into Word file, Excel file or Text file.
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Harmonic information window shows the information of Harmonics.

Measurement information window shows the information about measurement 
of FFT.

Measurement Parameters:

 : Amplitude of the fundamental frequency

 : Sum of Amplitude of Harmornic (excluding fundamental frequency)

 : Sum of Noise (excluding fundamental frequency, Harmonics, DC and 

Nyquist bins)
     : Total Number of bins

    : Total Number of bins of Harmonic
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   : Total Number of bins of Noise.

SNR (Signal to Noise Ratio): The ratio of the amplitude of the fundamental 
frequency to the Noise.

ENOB (Effective Number of Bits) : The number of bits in an ideal converter 
that would be required to give the same SNR performance.

SINAD (Signal to Noise and Distortion):The ratio of the amplitude of 
fundamental frequency to the Noise, but Noise include Harmonics.

-THD (Total Harmonic Distortion): The ratio of the RMS sum of the harmonics 
to

the RMS value of the fundamental.

SFDR (Spurious Free Dynamic Range): The ratio of the RMS signal 
amplitude to the RMS value of the peak spurious spectral component. The 
peak spurious component may or may not be a harmonic. 

 : The RMS value of the peak spurious spectral component.

Total Power: The RMS value of the sum of all spectral components.

 : Sum of Noise excluding DC and Nyquist.
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<![endif]>

The FFT display Windows:

Set referance

Click  in Toolbar to set REF channel.
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The Reference Channel Function:
 Turn On/Off: Turn on/off the reference channel.
 Volt/DIV: Channel the resolution of the reference channel.
 Reset: Reset the reference channel vertical position to zero.

The Reference Waveform Display Window:

Note: If you turn on the “Reference” channel, the load file window will appear.

Set Horizontal System

The following figure shows the Horizontal System window. It shows the 
horizontal parameters settings.

              

1. Time/DIV: leads the setting of the time base parameters
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2. Format: leads the setting of the horizontal format parameters
The time base ranges of the oscilloscope is listed as follows. The horizontal 
scan speed is from 4ns/div to 1hour/div.
In the “Format” menu of the “Horizontal” menu, select the display mode to Y-
T, X-Y .

               

Set Trigger System

Click “Trigger” in main menu

The trigger determines when the oscilloscope starts to acquire data and 
display a waveform. When a trigger is set up properly, it can convert unstable 
displays or blank screens into meaningful waveforms.

If the oscilloscope wants to acquire a waveform, it collects enough data so 
that it can draw the waveform to the left of the trigger point. The oscilloscope 
continues to acquire data while waiting for the trigger condition to occur. The 
oscilloscope continues to acquire enough data so that it can draw the 
waveform to the right of the trigger point after it detects a trigger,.

The Edge trigger determines whether the oscilloscope finds the trigger point 
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on the rising or the falling edge of a signal. Select Edge trigger mode to 
trigger on Rising edge or Falling edge.

Mode: Select the trigger mode.

    

The oscilloscope only provides edge trigger mode.
Sweep: Set the sweep mode to Auto, Normal or Single.

    

Auto: Acquire waveform even no trigger occurred
Normal: Acquire waveform when trigger occurred.
Single: Acquire waveform when trigger occurred then stop

Source: You can use the trigger source options to select the signal that the 
oscilloscope uses as a trigger. The source can be any signal 
connected to a channel BNC, or to the EXT. BNC.

CH1: Select CH1 as trigger signal
CH2: Select CH2 as trigger signal

Slope: Set the slope to Rising (+) or Falling (-).

Rising: Trigger on rising edge
Falling: Trigger on falling edge

36
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Measure Signal

 Cursor

 Measure

Cursor Menu

Click “Cursor” in main menu

This method allows you to take measurements by moving the cursors

1. Source

The user can set the source to CH1,  CH2,  FFT and MATH. But the FFT 
source can only use Trace type.

When you use cursors, be sure to set the Source to the waveform on the 
display that you want to measure.

2. Type

There are four types of cursors: Cross, Vertical and Horizontal

1) Cross
The Cross cursors appear as cross lines on the display and measure 
the vertical and horizontal parameters.

37
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The Cross cursor display window

The Cross measure result displays on status bar

2) Vertical
The Vertical cursors appear as vertical lines on the display and 
measure the vertical parameters.

The Vertical cursor display window

38
The User’s Manual



                                                        Hantek 6022BE                                                            

The Vertical cursor measure result display on status bar

3) Horizontal
The Horizontal cursors appear as horizontal lines on the display and 
measure the horizontal parameters.

The Horizontal cursor display window
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The Horizontal cursor measure result display on status bar

To acquire and display a signal, please do the steps as follows:
Connect signal to CH1 by using probe
The DSO set the vertical, horizontal, and triggers controls at the best status 
automatically. Also, you can adjust the controls to meet your measurement to 
optimize the waveform display.
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Measure

Select Channel

  

  

Maximum: Voltage of the absolute maximum level, Measured over the entire 
waveform

Minimum: Voltage of the absolute minimum level, Measured over the entire 
waveform

Peak  To  Peak:  Peak-to-peak  =  Max  –  Min,  Measured  over  the  entire 
waveform

Top: Voltage of the statistical maximum level, Measured over the entire 
waveform

Base: Voltage of the statistical minimum level, Measured over the entire 
waveform

Middle: Voltage of the 50% level from base to top
RMS: The Root Mean Square voltage over the entire waveform
Amplitude: Amp = Base – Top, Measured over the entire waveform
Mean: The arithmetic mean over the entire waveform
Cycle Mean: The arithmetic mean over the first cycle in the waveform
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Preshoot: Positive Overshoot = (Max - Top)/Amp x 100 %, Measured over the 
entire waveform

Overshoot: Negative Overshoot = (Base - Min)/Amp x 100 %, Measured over 
the entire waveform
Period: Time to take for the first signal cycle to complete in the waveform
Frequency: Reciprocal of the period of the first cycle in the waveform
Rise Time: Time taken from lower threshold to upper threshold
Fall Time: Time taken from upper threshold to lower threshold
+Duty Cycle: Positive Duty Cycle = (Positive Pulse Width)/Period x 100%, 

Measured of the first cycle in waveform
-Duty Cycle: Negative Duty Cycle = (Negative Pulse Width)/Period x 100%, 

Measured of the first cycle in waveform
+Pulse Width: Measured of the first positive pulse in the waveform. The time 

between the 50% amplitude points
-Pulse Width: Measured of the first negative pulse in the waveform. The time 
between the 50% amplitude points
1. To measure the frequency and “Vpp”, you can do these steps as follows:
2. Click the  button, the frequency of the signal display on the 

bottom of the waveform interface.

3. Click the  button, the “Vpp” of the signal will also display 

on the bottom of the waveform interface.

4. To clear the measurement on the waveform interface, click the  button.

The results of measure display in Information output.

42
The User’s Manual



                                                        Hantek 6022BE                                                            

  

The Utility Function

Click the “Menu -> Utility” to get into the “Utility” menu.

The “Utility” Functions:

 Calibrate

 Factory Setup

 Interpolation

Factory Setup

Click “Factory Setup” in “Utility” menu to load default setups

When you click the Factory Setup in Utility menu, the oscilloscope displays 
the CH1 and CH2 waveforms and removes all other waveforms. 

The oscilloscope set up for normal operation when it is shipped from the 
factory and can be recalled at anytime by user.

The Factory Setup function does not reset Date and time.
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Interpolation

Click “Utility->Interpolation”

The Step Interpolation

The Linear Interpolation
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The Sin(x)/x Interpolation

Note: The default interpolation mode is Sin(x)/x.
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The display System

Click “Display” in main menu
The following figure shows the display system menu. It shows the display 
parameters setting.

 Type

 Grid

 Intensity

Display type

Click “Type” in “Display” menu.
The following figure shows the type parameters setting.

If the Vectors type mode is selected, the waveform will be displayed as 
following figure.
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If the Dots type mode is selected, the waveform will be displayed as following 
figure.
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Display Grid

Click “Display” in main menu

The grid shows:

The grid not shows:
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Display Intensity

Click “Display->Intensity” in main menu 
The following figure shows the intensity dialog. It shows the display 
parameters setting.

You can change the grid and waveform color intensity in this dialog.
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Save and Load

Click “File” in main menu to save waveform, setups and screen

1. Save Data
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Save waveform data 

2. Save Setups
Save the current oscilloscope setups to file

Click “File” in main menu to recall saved waveform, setup

1. Load Data
Load the waveform

2. Load Setup
Load the instrument that had saved

Print

1.  Click “Print” in “File” menu to set the printer to print the current waveform.
2.        Click the “PrintPreview” in “File” menu to get into the Preview window.
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In ”PrintPreview” window, use the  button to change the size of 
the waveform graph. Click the “Close” button to turn this window off and 
click the “Print” button to print the report.

Chapter 4 Application Example

 Simple Measurement

 Capturing a Single-Shot Signal

 The Application of the X-Y

 Taking Cursor Measurement
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 Simple Measurement

 To acquire and display a signal, please do the steps as follows:
Connect signal to CH1 by using probe
The DSO set the vertical, horizontal, and triggers controls at the best status 
automatically. Also, you can adjust the controls to meet your measurement to 
optimize the waveform display.

           

1.To measure the frequency and “Vpp”, you can do these steps as follows:
2.Click the  button,  the frequency of the signal  display on the 
bottom of the waveform interface.

3.Click the  button, the “Vpp” of the signal will also display on 

the bottom of the waveform interface.

4.To clear the measurement on the waveform interface, click the  button.
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The results of measure display in Information output.

  

Capturing a Single-Shot Signal

To capture a single event, it needs to gather some pre-test knowledge of the 
signal in order to set up the trigger level and slope correctly. For example, if  
the event is derived from 3.3V COMS logic, a trigger level of 1.2 or higher  
Volts should work on a rising edge. 
 
Do these steps as follows: 
 
1. Set the probe and the channel attenuations to X 10. 

2. Set up the trigger in the Trigger Menu, or in the Trigger Setting window. 

1) Adjust the Trigger Mode to Edge. 
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2) Set the Trigger Sweep to Single.

3) Set the Trigger Source to CH1. 

4) Set the Trigger Slope to “+” which means you select the rising edge.

5) Adjust the Volts/Div and the time base in a proper range for the signal. 

6) Drag the trigger level sign on the waveform display screen to proper 
position. It’s usually higher a little above the normal level.

7) Click  to start capturing. When the trigger conditions are met, data 

appears  on  the  display  representing  the  data  points  that  the 
oscilloscope obtained with one acquisition. 

.

The Application of the X-Y Operation

X-Y Plot  acts  to  analyze  correlation  of  data  of  two  channels.  Lissajous 
diagram is displayed in the screen when you use X-Y Plot, which enables to 
compare  frequencies,  amplitudes  and  phases  of  counterpart  waveform 
against  the  reference  waveform.  This  makes  it  possible  to  compare  and 
analyze frequency, amplitude and phase between input and output.

Do these steps as follows: 

1. Set the probe attenuation to “x10”. Set the switch to “x10” on the probes. 
2. Connect the CH1 probe to the input of the circuit, and connect the CH2 

probe to the output of the circuit. 
3. Click ”Autoset”  button. 
4. Adjust  the  vertical  scale  and offset  to  display approximately the same 

amplitude signals on each channel.
5. Select X-Y format at Horizontal window. The oscilloscope will displays a 

Lissajous pattern representing the input and the output characteristics of 
the circuit. 

6. Adjust the scale and offset of the horizontal and vertical to a desirable 
waveform display. The following picture shows a typical example.

7. Apply the Ellipse Method to observe the phase difference between the two 
channels.
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Signal in X-Y Format:

Instruction of the Ellipse Method
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Sinθ = A/B  or  C/D,  where θ = phase shift  (in  degrees)  between the two 
signals. 
From the formula above: 

θ = ±arcsine (A/B) or ±arcsine (C/D)

θ must be in the range of (0~π/2) or (3π/2~2π) if the main axis of the ellipse is 
between I and III quadrant, . If the main axis is at II and IV quadrant, θ must  
be in the range of (π/2~π) or (π~3π/2).

Taking Cursor Measurements

Use cursors to make time and amplitude measurements on a waveform 
quickly. 
Measure the Peak Frequency or Time of the First Sine Waveform
Do these steps: 
1. Click “Cursor->Source”, select CH1 (select CH2 if you want measure 

CH2).
2. Click “Cursor->Type”, select Vertical.
3. Push left mouse button, and the vertical lines appear.
4. Drag the mouse button to the point you want to measure.
5. Release the left mouse button, the frequency difference and time 

difference will be shown at the status bar.
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Measure the Frequency and Time:

Read the details showing in the status bar.

Measure the Amplitude of the First Waveform Peak of the Waveform
Do these steps:
1. Click “Cursor->Source”, select CH1 (select CH2 if you want measure 

CH2).
2. Click “Cursor->Type”, select Horizontal.
3. Push left mouse button, and the Horizontal lines appear.
4. Drag the mouse button to the point you want to measure.
5. Release the left mouse button, the voltage difference will be shown at the 

status bar.
Measure the Amplitude:
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Read the details showing in the status bar.

Note: Click “Cursor->Type”, select “Cross”, you can measure time and 

amplitude at one time.
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Appendix

 Appendix A: Specification

 Appendix B: General Maintenance

 Appendix C: Services and Support
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Appendix A: Specifications

Specifications Table:

Input 
Real Real-time sampling:48MS/s

Channels 2 Channels 
Bandwidth 20MHz (-3dB)

Vertical resolution 8 bits/channel 
Gain range 10mV ~ 5V/div @ x1 probe(10mV, 20mV, 50mV, 100mV, 

200mV, 500mV, 1V, 2V, 5V/div1,2,5 sequence)
100mV ~ 50V/div @ x10 probe
1V ~ 500V/div @ x100 probe
10V ~ 5KV/div @ x1000 probe

Range 8 divisions 
Offset level +/-4 divisions 
Coupling DC
Offset increments 0.02 div 
Impedance 1M ohm 
DC accuracy +/-3% 
Input protection 35Vpk (DC + peak AC < 10 kHz, without external 

attenuation)
Display Mode Y-T, X-Y 
Timebase 
Timebase range 4ns/div ~ 1h/div(4ns, 10ns, 20ns, 40ns, 100ns, 200ns, 

400ns, 1us, 2us, 4us, 10us, 20us, 40us, 100us, 200us, 
400us, 1ms, 2ms, 4ms, 10ms, 20ms, 40ms, 100ms, 
200ms, 400ms, 1s,2s, 4s, 
10s,20s,40s,10m,20m,40m,1h /div  1-2-4 sequence)

Range 10 divisions 
Buffer Size Max. 1M samples/channel

Trigger 
Type Edge trigger

Mode Auto, Normal and Single 
Autoset Yes 
Range 10 divisions 
Trigger level +/-4 divisions 
Settabillity 0.02 div increments 
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Math 
Measurements Vp-p, Vmax, Vmin, Vmean, Vrms, Vamp, Vtop, Vbase, 

Vmid,positive overshoot, negative overshoot, cycle mean, 
cycle RMS, period, frequency, positive pulse width, 
negative pulse width, rise time (10%~90%), fall time 
(10%~90%), positive duty cycle, negative duty cycle 

Math Addition, Subtraction, Multiplication, Division 
FFT Rectangular, Hanning, Hamming, Blackman Window 
Physical 
Interface USB2.0 (USB1.1 compatible)
Power No external power source required. 

Bus-powered from USB 
Dimensions 187 x100 x 33(mm)

Appendix B: General Maintenance

General Care

Do not store or leave the oscilloscope where the device will be exposed to 
direct sunlight for long periods of time.

Caution

To avoid damages to the device or probes, do not expose them to sprays, 
liquids or solvents.

Cleaning

Inspect the device and probes as often as operating conditions require. 
Make sure the device disconnect form all power sources.

To clean the exterior surface, perform the following steps:

1. Remove loose dust on the outside of the oscilloscope and probes with 
a lint-free cloth. Use care to avoid scratching the clear glass display 
filter.

2. Use a soft cloth dampened with water to clean the device. 

Caution

To avoid damages to the surface of the device or probes not use any 
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abrasive or chemical cleaning agents.

Appendix C: Services and Support

Thank you for choosing HANTEK. Please contact us through the following ways should 

you have any inquiry regarding our products. We shall do our best to help you.

1． Contact your local HANTEK distributor;

2． Contact your local HANTEK field office;

3． Contact HANTEK headquarters in China.

Headquarters

HANTEK Technologies Co., Ltd

http://www.hantek.net

Address：5F.NO. 177 zhuzhou road(huite industry city),QingDao,China

266000

Tel: +86-532-88703687 / 88703697

Fax: +86-532-88705691

Email: service@hantek.com.cn

Technical Support

Tel: +86-532-88703687 (ext: 606)

Email: support@hantek.com.cn

Marketing Department

Tel: +86-532-88703687 (ext: 607) 

Email: david@hantek.com.cn

Sales Department

Tel: +86-532-88703687 (ext: 605)

E-mail: sales@Hantekins.com
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